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Session 2 

On an Alien Planet 
 

 

In this session, students continue animating their space adventure. They create 

two scenes using frame by frame animation. To start, they create the planet 

surface that shows grass growing and a flower blooming. Afterwards, they 

apply their new skills to make a hover craft drive over bumpy terrain. The 

session ends with students selecting an Animation Challenge and creating it 

using Frame by Frame Animation. 

 

Assignment 11: What Is Frame by Frame Animation? 

Assignment 12: Create Scene 2 – The Planet 

Assignment 13: Create Scene 3 – The Hover Craft 

Assignment 14: Frame by Frame Challenge 

 

Session 2 Review: About Frame by Frame Animation 

Session 2 Skill Review: Animate a Dog's Tail Wagging 

Session 2 Extension Activity: Using Layers 
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Assignment 11  What Is Frame by Frame Animation? 

In this session, you are going to animate using frame by frame animation. 

Frame by frame animation is used to move an object from one position to 

another, by creating content in every frame. Although creating this type of 

animation does take time, it is a great way to gain control over how an 

object will move across the stage. In this assignment, you will read about 

frame by frame animation and view sample videos. 

 

What Is Frame by Frame Animation? 

 

Frame by frame animation uses keyframes in EVERY frame of the Timeline. A keyframe copies the 

content from the previous keyframe. The keyframes in frame by frame animation are placed 

right beside each other. Slight changes are then made to the objects in each frame. These 

changes are seen as movement when the animated sequence is played. 

 

 

 
 

Frame by frame animation is a lot like what animators used to do in the past. Before there were 

computers, animators used to draw the character in a new position, one frame at a time. To 

create animation using this technique is a time-consuming task, however, it does offer lots of 

control over how the object moves. 

 

 

 

Questions about Frame by Frame Animation 

 

1. What is frame by frame animation? 

  

 Animation that is created by placing a keyframe in EVERY frame, with slight changes 

made to the content of each keyframe. 

 

 

 

2. Frame by frame animation uses keyframes. How is a keyframe different from a blank 

keyframe? 

  

 A blank keyframe is empty, whereas a keyframe copies the content of the previous 

keyframe. 

 

  

In frame by frame animation, a keyframe is 

placed into every frame of the Timeline. 
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Study the Frame by Frame Animation Samples 

 

View two sample videos created using frame by frame animation. One is of an alien landscape 

with an animated planet surface. The second is of a flying hover craft. Afterwards, answer the 

questions about frame by frame animation. 

 Access the Animate folder. Open the Scenes folder. 

 

The Alien 

 Double click the Scene 2 file to watch the animated scene. 

 

3. What different events occur in each frame of the animation? 

  

 

 

 

The grass gradually grows and the 

flower blooms. 

 

 Close the file. 

 

The Hover Craft 

 Double click the Scene 3 file to watch the animated scene. 

 

4. How would you describe the animation of the hover craft in this scene? 

  

 

 

 

It is choppy and slow. 

 

 Close the file. 
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Assignment 12  Create Scene 2 – The Planet 

In this assignment, you will create Scene 2 in your space adventure using frame 

by frame animation. Use your skills to draw the planet surface. Follow the 

instructions to animate the ground appearing, grass growing, and flower 

blooming. 

 

View a Sample Scene 

 Access the Animate folder. Open the Scenes folder. 

 Double click the Scene 2 file to watch a sample from an animated story. 

 
 

Open the Animate Document 

 Open the document in the Animate program. The document opens to show the last 

scene you were editing. In this case, the scene in view should be Scene 1. 

 

Insert a New Scene 

 

When making an animated story with the Animate program it is a good idea to divide the 

events into scenes. Each scene has its own stage, Timeline, and layers.  

 From the Insert menu, select Scene. 

 A new stage opens in the window. It has an empty Timeline. You will notice that the 

Scene Number reads Scene 2. 

 
 

View Each Scene in the Story 

 

Scene 1 has not been deleted. It is still part of the animated story. You can easily switch from 

Scene 2 to Scene 1 and back again. Try it! 

 Click the Edit Scene arrow on the Edit Bar. From the list click Scene 1. 

 

 Click the Edit Scene arrow again and this time select Scene 2. 

  

If you cannot see the 

Scene Number, select 

Edit Bar from the 

Window menu. 

Please note, the sample 

includes sound, which is 

a feature that will be 

added to the Timeline in 

Session 6. 
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Insert the Alien Symbol from the Library 

 

In the previous session, you created an alien and placed it into the Library. The Library lets you 

use the same object repeatedly without needing to redraw it. Insert the alien from the Library. 

 From the Window menu, select Library. 

 Click on the alien symbol and drag it onto the stage. 

 

 Deselect the alien by pressing the ESC key on the keyboard. 

 

Animate the Ground Using Frame by Frame Animation 

 

You are going to have the ground gradually appear underneath the alien 

using frame by frame animation. Unlike the previous session when you used 

blank keyframes, you are going to use keyframes. The difference between the 

two is that a keyframe copies the content of the previous frames into the new 

one. This means everything you drew before the keyframe remains on the 

stage, whereas a blank keyframe is empty. 

 From the Tools Panel, select the Pencil Tool.  

 From the Properties tab, select a stroke color, size, and style. 

 

 Turn Object Drawing Mode OFF.  

 Click Pencil Mode in the Property Inspector or Tools Panel.  HINT: Try Smooth. 

 

 Starting from the left side of the stage, draw a short line. 

 

 Add a keyframe: 

o Right click on Frame 5 in the Timeline.  

o Select Insert Keyframe or press F6 on the keyboard.  

Draw a short line 

for the ground. 
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 Draw another short line and then add a keyframe: 

o Click the stage to deselect all objects.  TIP: CTRL + SHIFT+ A 

o Beginning where the last line ended, draw another short line.  

o Right click Frame 10 in the Timeline. Select Insert Keyframe or press F6. 

 Select Frame 1. Press the ENTER key to watch the animation. Notice it appears choppy. 

 Continue to draw short lines and add keyframes to the Timeline until the ground reaches 

across the entire stage.  

 
 

Animate Grass Using Frame by Frame Animation 
 

Frame by frame animation looks the best when there is a new action in EVERY 

frame. When the ground appears, it looks choppy. This is because there are 

several frames between keyframes. You are now going to make grass grow. This 

time there will be a keyframe in each consecutive frame. You will notice a big 

difference in the smoothness of the animation.  

 From the Tools Panel, select the Pencil Tool.  

 From the Properties tab, select a stroke color, size, and style. 

 Pick Pencil Mode from the Property Inspector or Tools Panel.  HINT: Try Smooth. 

 Draw a blade of grass near the left side of the stage coming up from the ground. 

 

 Click on the frame beside the last keyframe in the Timeline.  

Right click the mouse and select Insert Keyframe or press F6 on the keyboard. 

 

 

 Draw blades of grass: 

o Click the stage to deselect all objects.  TIP: CTRL + SHIFT+ A 

o Draw a blade of grass beside the last one you made.  

o Right click the frame beside the last keyframe in the Timeline.  

Select Insert Keyframe or press F6. 

o Repeat until the grass reaches across the stage. 

 
 

 Select Frame 1. Watch the animation by pressing the ENTER key. Notice that the grass 

grows quickly, and the animation is smooth.  

Add a keyframe right beside the last keyframe in the Timeline. 

You should have 

many keyframes in 

the Timeline. 

ground appears grass grows – each frame is a keyframe 
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Draw a Flower Blooming Using Frame by Frame Animation 
 

Make a flower grow. To start you will animate the stem and some leaves. After 

that the center of the flower will appear, with one petal at a time blooming. 
 

 Draw a stem: 

o From the Tools Panel, select the Pencil Tool.  

o From the Properties tab, select a stroke color, size, and style. 

o Turn Object Drawing Mode OFF.  

o Draw a stem. 

 

 Add a leaf: 

o Click on the frame beside the last keyframe in the Timeline.  

Right click the mouse and select Insert Keyframe or press F6 on the keyboard. 

o Click the stage to deselect all objects.  TIP: CTRL + SHIFT+ A 

o Draw a leaf onto the stem using the Pencil Tool.   

o Select the Paint Bucket Tool . Select a fill color.  
HINT: From the Tool Options set the Gap Size to Close Large Gaps.  

 

o Fill the leaf shape with color.  

 

 Complete the flower: 

o Click on the frame beside the last keyframe in the Timeline.  

Right click the mouse and select Insert Keyframe or press F6 on the keyboard. 

o Using the Pencil Tool draw the center of a flower.  Fill it with color.  

 

o Insert a keyframe into the Timeline.  

o Deselect all objects.  

o Using the Pencil Tool draw a petal.  Fill it with color.  

 

o Continue to draw petals and add keyframes until the flower has bloomed. 

 Select Frame 1. Watch the animation by pressing the ENTER key. 

  

TIP: To delete a keyframe 

right click on the frame in 

the Timeline and select 

Remove Frames. 
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Describe the Scene with Words 

 

Add text to describe the action in Scene 2. The viewer needs to be able to read the words at 

the SAME TIME as the action is occurring on the screen. Test the scene to discover a problem 

with the animated sequence and learn how to fix it. 

 Click on Frame 1. Use the Text Tool  to type the words:  

The alien looked around. Each day was the same. The grass grew and the flowers 

bloomed. He wanted to see something different. 

 

 

 Watch the story using the Test Scene feature: 

o From the Control menu select Test Scene. The movie opens into a preview pane and 

will continually loop. 

o What is the problem? The words disappear after the first frame. Had the text been 

added to Frame 1 before all the keyframes were added, it would be on the screen 

the entire time. This is because a keyframe copies the contents of the previous frame 

into the new one. However, the text was added later. 

 Click the Close button on the Test windowpane to exit the preview. 

 

Solve the Problem by Adding a New Layer 

 

To solve the problem, you need to add a layer to the Timeline. By placing objects on different 

layers, you can have different events occurring at the same time. 

 Click New Layer  at the bottom of the Layers area of the Timeline.  

 Notice how a new layer has now been added above Layer_1.  

The layer you are currently editing is blue. Study the layer area: 

 Show or Hide: Show or hide a layer. 

 Lock or Unlock: Set the layer to permit or prevent edits. 

 Show Layer as Outline: Display layer as solid or an outline like a coloring book. 

 

 

Rename a Layer 

 

It is a good idea to name a layer to tell about what types of objects are on it. You are going to 

rename Layer 2 to Words. 

 Double click on the text Layer_2.  

 Type Words. Press the ENTER key.  

The words must be in view 

for a long time so that 

they can be read. 

Discover how to fix the 

problem! 
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Move the Text from Layer_1 onto the Words Layer 

 

You now need to cut the words from Layer_1 and paste them onto the Words Layer. 

 Click on Layer_1.  

 Select Frame 1 in the Timeline.  

 From the Tools Panel, click the Selection Tool.  

 Select the text box in Frame 1. From the Edit menu, select Cut. Or right click and from the 

options, select Cut. 

 Click on the Words Layer. From the Edit menu, select Paste in Place. Or right click on the 

stage and select Paste in Place. 

 Study the Timeline to notice the change: 

 
 

Make the Words Appear at the Same Time the Action Occurs 

 Select Frame 1 in the Timeline.  

 Press ENTER to play the scene.  

Notice the text is in view the entire time that the action occurs. 

 

Complete the Scene 

 Use your skills to view the animation. Make edits to the scene. 

 
 

Test the Movie to Watch All the Scenes Play 

 From the Control menu, select Test Movie. 

 Select In Animate. 

 Watch the story. 

 When finished, close the Preview window. 

 

Save the Animate Document 

 From the File menu, select Save. 

 

Close the Animate Program 

ANIMATION TIPS 

Scene Is Too Short: If the scene is too short the words may be difficult to read. If this happens, draw another 

animated flower on the Layer_1 layer to extend the action. 

There Is No Room for an Extra Animated Object: If the scene is too short, but there is no room on the stage to 

create another object, place another keyframe in the Layer_1 and the Words layers. It should be about 15 

frames longer than the last keyframe. This will create a static image which will make the text easy to read. 

Words Disappear: If the scene does not play the words for the entire time, add a keyframe to the Timeline in 

the Words layer that is the same frame number as the keyframe that contains the final action in Layer_1. 
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Assignment 13  Create Scene 3 – The Hover Craft 

In this assignment, you will create Scene 3 in your space adventure using frame 

by frame animation. Use your skills to draw a hover craft. Follow the instructions 

to animate it driving over bumpy terrain. 

 

View a Sample Scene 

 Access the Animate folder. Open the Scenes folder. 

 Double click the Scene 3 file to watch a sample from an animated story. 

 

Open the Animate Document 

 Open the document in Animate 2022. The document opens to show the last scene you 

were editing. In this case the scene in view should be Scene 2. 

 

Insert a New Scene and Rename Layer 1 

 From the Insert menu, select Scene. 

 A new stage opens in the window. It has an empty Timeline. You will notice that the 

Scene Number reads Scene 3. 

 Double click Layer_1 and name it Hover_Craft. Press ENTER. 

 

Draw a Bumpy Planet Surface 

 On the Hover Craft layer, draw a bumpy planet surface. Be creative! If you need help, 

follow these instructions: 

o From the Tools Panel, select the Rectangle Tool.  

o Turn Object Drawing Mode OFF.  

o Select the SAME stroke and fill color.  

o Draw a rectangle. 

o From the Tools Panel, select the Pencil Tool.  

o Turn Object Drawing Mode OFF.  

Change the stroke color to the SAME color as the rectangle. 

o Place the pencil on the edge of the rectangle and start to draw a bumpy line. End 

the line by touching the edge of the rectangle. 

o From the Tools Panel, select the Paint Bucket Tool.   Select Close Large Gaps  as 

the gap size in the Options Tray. Fill the area with color. 

  

Please note, the sample 

includes sound, which is a 

feature that will be added to 

the Timeline in Session 6. 
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Draw a Hover Craft and Group All the Objects Together 

 Use your skills to create a vehicle that drives across the planet surface. 

 From the Tools Panel, click the Selection Tool.  

 Click and drag around the hover craft. 

 

 From the Modify menu, select Group. 

 

Animate the Hover Craft Using Frame by Frame Animation 

 Drag the hover craft to its starting point on Frame 1. Put it slightly off the stage. 

 Right click on Frame 2 in the Timeline.  

Select Insert Keyframe or press F6 on the keyboard. 

 Click on the stage to deselect all objects. 

 Click on the hover craft to select it. Make sure the terrain is not selected.  

 Use the arrow keys on the keyboard to move the hover craft a little up and towards the 

other edge of the stage. 

 Add a keyframe to Frame 3. Click on the hover craft to select it. Move it slightly down 

and towards the other edge of the stage. 

 Continue to add keyframes and move the hover craft slightly until it is off the other side of 

the stage. It should look as if it is driving over the bumpy terrain. 

 Use your skills to view the animation. 

 

Add Words on a New Layer to Describe the Action 

 Click New Layer  at the bottom of the Layers area of the Timeline. 

Rename the new layer Words. 

 On the Words layer, click on Frame 1.  

 Use the Text Tool  to type the words: 

He got into his hover craft and drove to the launch pad. 

 
 

Test the Scene 

 From the Control menu select Test Scene. 

Watch the hover craft fly across the planet surface. 

 Click the Close button on the Test windowpane to exit the preview. 

 

Save the Animate Document and Close the Program 

The object must be 

grouped to move it 

across the stage. 
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Assignment 14  Frame by Frame Animation Challenge 
 

You have learned how to animate objects using frame by frame animation. In  

this assignment are two animation challenges. You can add a flashing sign or a  

waving rock creature to Scene 3. Pick a challenge to practice your new skills. 

 

Animate a Flashing Sign 

1. Access the Animate folder. Open the Challenges folder.  

View the Sign file to watch a sample video. 

 

 

2. Open the space adventure in Animate 2022. View Scene 3. 
  

3. Click New Layer  at the bottom of the Layers area. Rename the layer Sign. 
  

4. Draw a sign using the drawing tools. 
 

 
 

5. Use the Text Tool  to add the planet name to the sign. 

    

  

6. Right click on the text box. Select Break Apart to ungroup the name 

into individual letters. 
  

7. Place a keyframe in Frame 2 of the Sign layer. Select Frame 2. From the Insert menu, 

select Timeline and then Keyframe, or press F6 on the keyboard. 
  

8. Change the first letter to another color: 

 a. Click on the stage to deselect all objects.  

 b. Select the first letter using the Selection Tool.  

 c. Select a color from the Fill Control.  
  

9. Place a keyframe in Frame 3 of the Sign layer. 
  

10. Deselect all objects. Change the next letter to another color. 
  

11. Continue to add keyframes and change the letter color until all letters have changed. 

  

12. Copy the animation you have just created to have it repeat itself: 

 a. Click on the last keyframe in the Sign layer. Hold the SHIFT key and click Frame 1. 

 b. Right click on the selected frames and select Copy Frames. 

 c. Right click inside the next blank frame in the Sign layer. Select Paste Frames. 

  Click away from the frame or timeline to see the pasted frames. 

 d. You can keep pasting the frames, by right clicking on the next blank frame and 

then selecting Paste Frames.  

 

TIP: The landscape, hover craft, or words might be in your way. You may want to temporarily 

hide  a layer, such as the Hover Craft or Words layer, while drawing. 

TIP: Does the sign display longer than the Hover Craft and Word layers? To solve this problem, 

select the frames in the Sign layer. Right click on the selection and select Remove Frames. 

The animated sign has letters 

that change color one letter 

at a time.  
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Animate a Waving Rock Creature 

1. Access the Animate folder. Open the Challenges folder.  

View the Wave file to watch a sample video. 

 

 

  

2. Open the space adventure in Animate 2022. View Scene 3. 
  

3. Click New Layer  at the bottom of the Layers area. Rename the layer Wave. 
  

4. Draw a rock creature using the drawing tools. Draw the body and 

add a face. Draw the arm with Object Drawing Mode ON.   

  

 

5. If the arm and hand are not grouped together, group them. 
  

6. Place a keyframe in Frame 2 of the Wave layer. Select Frame 2. From the Insert menu, 

select Timeline and then Keyframe, or press F6 on the keyboard. 
  

7. Move the registration point to set how the arm pivots: 

 a. Click the Free Transform Tool . 

 b. If necessary, click on a blank area of the stage to deselect all objects. 

 c. Click on the arm to select it. Click on the registration point - it is the round circle 

inside the bounding box. 

 d. Drag it to the point where you want the arm to pivot (at the body). 

 

8. Rotate the arm slightly (up or down). 

9. Place a keyframe in Frame 3. 

10. Deselect all objects. Rotate the arm (in the same direction as step 8). 

11. Continue to add keyframes until the arm has moved all the way up or down. 

12. Copy the animation you have just created to have it repeat itself: 

 a. Click on the last keyframe in the Wave layer. Hold the SHIFT key and click Frame 1. 

 b. Right click on the selected frames and select Copy Frames. 

 c. Right click inside the next blank frame in the Wave layer. Select Paste Frames. 

  Click away from the frame or timeline to see the pasted frames. 

 d. You can keep pasting the frames, by right clicking on the next blank frame and 

then selecting Paste Frames.  

 
 

Save the Animate Document and Close the Program 

TIP: The landscape, hover craft, or words might be in your way. You may want to temporarily 

hide  a layer, such as the Hover Craft or Words layer, while drawing. 

TIP: Does the rock display longer than the Hover Craft and Word layers? To solve this problem, 

select the frames in the Wave layer. Right click on the selection and select Remove Frames. 

The waving rock creature has 

an arm that moves up and 

down to wave goodbye to 

the alien in the hover craft.  

Move the registration point to 

the body. This will create 

realistic movement.  
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Session 2 Review: About Frame by Frame Animation 

Match the tool to its function. 
 

1. D 
 

A. Display objects on a layer as solid or an outline. 

 

2. A 
 

B. Add a layer. 

 

3. E 
 

C. Select a scene to edit. 

 

4. C 
 

D. Show or hide a layer. 

 

5. B 
 

E. Lock or unlock a layer. 
 

/5 

Match the term to its definition. 
 

6. B frame by frame animation A. A gallery of stored objects 

 

 

7. C scene B. Animation that has a keyframe in every frame 

 

 

8. E Timeline C. A part of an Animate document that contains 

its own stage, Timeline, and layers  

 

9. D keyframe D. A frame in an animated sequence that 

contains drawn objects  

 

10. A Library E. Made up of layers and frames, it organizes and 

controls a document's content over time  

 

11. F frame F. A single unit in a Timeline 

 

 

12. G layer G. A division of the Timeline into parts that allow 

objects to be stacked on top of each other  

 

/7 

Write a short answer for each question. 
 

13. What is the difference between a keyframe and a blank keyframe? 

 A blank keyframe is empty, whereas a keyframe copies the content of the previous 

frames. 

  

14. What keyboard key will add a keyframe to the Timeline? F6 

   

15. What keyboard key will play the Timeline? ENTER 

/3 

TOTAL: /15 
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Session 2 Skill Review: Animate a Dog's Tail Wagging 
 

Frame by frame animation can be used to animate objects one frame at a time using 

keyframes. In this assignment, you apply your knowledge to create a dog with a wagging tail. 
 

1. View the Tail file to watch a sample video. Ask your teacher for the file. 

 

 
 

2. Open Animate.  From the File menu select New. 

 a. Select Education. Pick Standard Video. 

 b. Select ActionScript 3.0 as the Platform Type. 
 

3. Rename Layer_1 to Dog. 

4. Draw a creature using the drawing tools. DO NOT INCLUDE A TAIL. 

 
5. Group the creature: 

 a. Select the Selection Tool.  Click and drag to draw a box around the dog. 

 b. From the Modify menu, click Group. 
 

6. Position the dog on the stage. 

7. Draw a tail. If the parts of the tail are not grouped, group them.  

8. Position the tail so it looks like it is attached to the creature. If necessary, change the 

object order. Right click the tail. Select Arrange. Click Send to Back. 

9. Place a keyframe in Frame 2 of the Dog layer. 

10. Move the registration point to set how the tail pivots: 

 a. Click the Free Transform Tool.  

 b. If necessary, click on a blank area of the stage to deselect all objects. 

 c. Click on the tail to select it. Click on the registration point -  

it is the round circle inside the bounding box.  

 d. Drag it to the point where the tail should pivot. (at the body) 

 e. Rotate the tail a small amount to look like it is wagging.  
 

11. Animate the tail: 

 a. Click the Free Transform Tool.  

 b. If necessary, click on a blank area of the stage to deselect all objects. 

 c. Place a keyframe in Frame 3. 

 d. Deselect all objects. Rotate the tail a bit more. 

 e. Continue to add keyframes until the tail has moved in one direction. 
 

12. Copy the animation you have just created to have it repeat itself: 

 a. Click on the last keyframe in the Dog layer. Hold the SHIFT key and click Frame 1. 

 b. Right click on the selected frames and select Copy Frames. 

 c. Right click inside the next blank frame in the Dog layer. Select Paste Frames. 

 d. Keep pasting frames. Right click on the next blank frame and select Paste Frames.  
 

13. View the animation. IF you find the tail moves too fast, adjust the frames per second. 

Click on the stage. In the Properties panel, on the Docs tab, edit FPS. Change to 12 FPS. 

14. Save the file as tail. Close the Animate Program. 

The tail wags up and 

down using frame by 

frame animation.  
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Session 2 Extension Activity: Using Layers 

 

In this extension activity, you will explore the Layers area. Learn how to insert, 

rename, move, hide, lock, view, and delete layers. 
 

What Is a Layer? 

 

The Layers panel is part of the Timeline. A layer is a row in a Timeline. It is used to organize parts of 

a scene. By placing objects on different layers, it is possible to have several animations appear 

at the same time. 
 

Layers are used to: 

• organize a scene into manageable parts 

• adjust the stacking order of objects on the stage 

• display objects as outlines 

• temporarily hide objects to declutter the stage 

• structure animated sequences 

• navigate to a keyframe quickly 

• add a camera view 

• create depth on the stage 

 

About the Layers Panel 
 

The layer area of the Timeline has tools for managing layers. Read to learn about each part: 
 

 View Only Active Layer: Temporarily hide inactive layers. 

 Add Camera: Add a camera layer to pan and zoom the stage. 

 Show Parenting View: Connect layers or objects to control movement. 

 Invoke Layer Depth Panel: Create depth on the stage.  

   

 New Layer: Insert a new layer on the Timeline. 

 

 New Folder: Create a folder to group layers. 

 Delete: Remove a layer from the Timeline. 

 Highlight Layers: Color code layers to easily identify each row. 

 Show Layer as Outline: Display objects as solid or black and white line drawings. 

 Show or Hide Layers: Display or temporarily remove a layer from view.  

 Lock or Unlock Layers: Permit or prevent edits to a layer.  

 

1. Create a new file in Animate. 
  

2. Rename a layer: 

 a. Double click on Layer _1. 

 b. Type Circle. Press the ENTER key. 
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3. Add an object to a layer: 

 a. From the Tools Panel, select the Oval Tool.  

 b. From the Properties panel, set the color and style. 

 c. Draw a circle. 
  

4. Insert a new layer to organize objects: 

 a. Add a layer by clicking New Layer.  

 b. Double click on Layer _2. 

 c. Type Square. Press the ENTER key. 

 d. From the Tools Panel, select the Rectangle Tool.  

 e. Use your skills to place the rectangle directly over top of the circle. 
  

5. Adjust the stacking order of objects: 

 a. Click on the Square layer to select it. It turns blue to show it is active. 

 b. Drag it down below the Circle layer. 
  

6. Hide or show a layer: 

 a. Click on the Circle layer. 

 b. Hide it from view by clicking on Show or Hide Layer . 

  

 

 c. Click  to show the layer again. 
  

7. Lock and unlock a layer: 

 a. Click on the Circle layer. 

 b. Lock it so that no changes can be made, by clicking on the Lock or Unlock Layer  

dot. Now try to draw something on the layer – you cannot! 

  

 

 c. Click the lock symbol  to unlock the layer. 
  

8. Change the view of a layer from an outline to solid: 

 a. Click on the Circle layer. 

 b. Change the objects on each layer to an outline of the shape by clicking on the 

Show Layer as Outlines  square in the layer. 

  

 

 c. Click it again  to return it to a solid. 
  

9. Delete a layer: 

 a. Click on the Square layer. 

 b. Click Delete   to remove it. 
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TechnoAnimate Checklist 

✓

Content 

The events in the movie are logically sequenced. 

The action is told using well drawn characters or objects. 

The words explain the action in the story and are easy to read. 

The words are spelled correctly. 

Animation 

The animation clearly illustrates the action in the story. 

The animation is well-selected for the purpose. 

There is a variety of animation to add interest to the story. 

There is enough time to read the words. 

There is enough time to view the action. 

Sound 

The sound enhances the story. 

The sound is synchronized with the action. 

Originality and Creativity 

The movie holds viewer interest. 

The content of the movie is unique. 
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Session 8 
Review 

Review the learning objectives addressed in the TechnoAnimate project. 

➢ Reflection 

➢ Skill Summary 

➢ Animate Marking Sheet 

➢ Animate Rubric 

 

  

https://www.technokids.com/store/high-school/technoanimate/animation-for-beginners.aspx


 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Animate Marking Sheet 
 

Content  

The events in the movie are logically sequenced.  

The action is told using well drawn characters or objects.  

The words explain the action in the story and are easy to read.  

The words are spelled correctly. /10 

Animation  

The animation clearly illustrates the action in the story.  

The animation is well-selected for the purpose.  

There is a variety of animation to add interest to the story.  

There is enough time to read the words.  

There is enough time to view the action. /10 

Sound  

The sound enhances the story.  

The sound is synchronized with the action. /5 

Originality and Creativity  

The movie holds viewer interest.  

The content of the movie is unique. /5 

TOTAL: /30 
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Excellent - Wow! Competent - Great Work! Emerging - Getting There! Incomplete - Keep Trying! 

Story Content • tells a story convincingly with all 
elements: characters, objects, 
text, and background 

• tells a story accurately with most 
elements: characters, objects, 
text, and background 

• tells a story with some elements: 
characters, objects, text, and 
background 

• tells a story with few elements: 
characters, objects, text, and 
background but plot is missing 
key parts 

Drawing Skills • demonstrates an exceptional 
understanding of drawing tools 

• demonstrates a strong 
understanding of drawing tools 

• demonstrates a basic 
understanding of drawing tools 

• demonstrates an incomplete 
understanding of drawing tools  

Animation • illustrates the story action highly 
effectively using a variety of 
animation types (frame by frame, 
motion tween, shape tween, 
and/or motion path) 

• illustrates the story action 
accurately using a variety of 
animation types (frame by frame, 
motion tween, shape tween, 
and/or motion path) 

• illustrates the story action using 
limited animation types (frame by 
frame, motion tween, shape 
tween, and/or motion path) 

• illustrates the story action using 
minimal animation types (frame 
by frame, motion tween, shape 
tween, and/or motion path) 

 • flows smoothly and action is well-
paced 

• flows smoothly • plays with some pauses or breaks  • plays in a disjointed way 

 • uses calculated and accurate 
timing to read words and view the 
action 

• uses appropriate timing to read 
words and view the action 

• uses some suitable timing to read 
words and view the action 

• uses inadequate or prolonged 
timing to read words and view the 
action 

Organization • sequences all events logically • sequences most events logically • sequences some events logically • sequences events in a confusing 
order 

 • labels all scenes and layers clearly  • labels most scenes and layers  • labels some scenes and layers  • labels few or no scenes and layers 

 • stores all graphic elements in a 
Library 

• stores most graphic elements in a 
Library 

• stores some graphic elements in a 
Library 

• stores few or no graphic elements 
in a Library 

Sound • fits the story line and mood very 
effectively 

• fits the story line and mood  • fits the story line somewhat • does not fit the story line  

 • synchronizes precisely with the 
action 

• synchronizes with the action • matches the action moderately • does not match the action 

Originality and 
Creativity 

• applies a very unique approach 
that enhances the project and 
thoroughly engages the viewer 

• applies a thoughtful approach to 
engage the viewer 

• applies some original touches  • applies few or no unique ideas 
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